
 

 

 

 

 

 

    

 

 
IDA ICE  

Getting Started 

 

 

 

 

EQUA Simulation AB 

 
February 2016 

 
Manual version: 4.7  

 

 

 
Copyright EQUA Simulation AB 2009-2016 



Getting Started with IDA Indoor Climate and Energy 

 

 

- 2 - 

 

 

 

Contents 

Contents ............................................................................................................................... 2 

Introduction .......................................................................................................................... 3 

Caption for symbols in screenshots ............................................................................ 3 

Help texts .................................................................................................................... 3 

Overview of Standard Level ........................................................................................ 4 

General tab .................................................................................................................. 6 

Floor plan tab .............................................................................................................. 7 

3D tab .......................................................................................................................... 8 

Simulation tab ............................................................................................................. 9 

Summary tab ............................................................................................................. 10 

Details tab ................................................................................................................. 11 

1. Building Geometry and CAD Import ............................................................................ 12 

2. Define Default Constructions ........................................................................................ 16 

3. Zone Template ............................................................................................................... 20 

4. Inserting Zones .............................................................................................................. 23 

5. Inserting Windows and Internal Openings ................................................................... 30 

6. Site Shading and Orientation ........................................................................................ 36 

7. Location and Weather.................................................................................................... 39 

8. Ventilation System ........................................................................................................ 40 

9. Infiltration ..................................................................................................................... 41 

10. Thermal Bridges ........................................................................................................ 42 

11. Ground Properties ..................................................................................................... 45 

12. System Distribution Losses ...................................................................................... 46 

13. Heating Load Calculation and Results ..................................................................... 47 

14. Cooling Load Calculation and Results ...................................................................... 50 

15. Energy Calculation and Results ............................................................................... 55 

16. Simulation Summary ................................................................................................ 59 

17. Time Series Diagrams ............................................................................................... 61 

18. Systems Energy Report ............................................................................................. 64 

19. More… Reports .......................................................................................................... 67 

 



Getting Started with IDA Indoor Climate and Energy 

 

 

- 3 - 

Introduction 

IDA Indoor Climate and Energy (IDA ICE) is a dynamic multi-zone simulation 

application for accurate study of indoor climate of individual zones as well as the energy 

consumption of an entire building.  

 

The user interface has been designed to make it easy to build and simulate typical cases, 

but also offers the advanced user the full flexibility of IDA. To provide both efficiency 

and flexibility, IDA ICE works with three user levels: Wizard, Standard and Advanced. 

This manual shows how to start working in the standard level. 

 

IDA ICE  is delivered in two editions: Standard and Expert. The screen shots shown are 

from the Expert edition of the program. Please note that unless specifically mentioned, 

all steps can be undertaken with the standard edition. 

 

The introduction gives a brief overview of the user interface. It roughly explains what 

can be done where, but does not go into details. You should not worry about this and try 

to make it to the end of the introduction. The actual learning example starts in Chapter 

1. From that point, take care in always trying to understand what you are doing.  

 

Basically, the screenshots will show you how to act, while the text explains what you are 

doing and provides useful hints. 

 

 

Caption for symbols in screenshots 

 Numbers with reference from screenshot to text 

�  Hints about possible actions, not belonging to the learning example. These 

can safely be omitted without losing the thread. 

 Indication of a screen segment 

 Single left mouse click 

 Single right mouse click 

 Double left mouse click 

 Drag and drop 

 Drag and drop with pressed Ctrl-key 

 

 

Help texts 
Make sure you take a look at the online help texts as well. These are easiest reached by 

pressing F1, when you have the dubious window active. Alternatively choose Help -> 

Help topic to find help texts, or use the cursor (in the toolbar) and point at the element 

in question on the screen. 
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Overview of Standard Level  
(Does not belong to the main tutorial example – no need to follow details) 

 
 Screenshot 1 

�  Start with an empty building. 

�  Start with a building with a single zone. Unlike starting with an empty 

building, a project ready to simulate will be opened up. This building contains 

the geometry of a single zone with a southerly orientation. The building has 

default settings for wall constructions, glazing, shadings, location, synthetic 

weather, mechanical zone ventilation, controller setpoints and everything 

else needed for a simulation. 

�  Open or close (toggle) the side bar. The side bar contains Palettes (list of objects 

to insert) and Properties (some editable parameters for the selected object). 

�  Open or close the log window. The log window contains error and warning 

messages. By double clicking on an error message, the program will attempt to 

take you to the location where the problem can be addressed. Objects mentioned 

in the error message are linked: Clicking on the link will open up the object 

form. 

�  General tab: Main information about the project: Global Data, HVAC 

Systems, Energy Meters and tables with model details. 

�  Floor plan tab: 2D view of the building geometry. Building body, zones, 

windows and doors can be inserted and edited here. 

�  3D tab: The model and results can be visualized and animated here. Selecting 

an object will open up a property page in the side bar. Double clicking on an 

object will open up the object form. 

�  Simulation tab: Simulation options are given and all different kind of 

simulation runs are started here. Statistics from made simulations are shown 

as well as links to key results. 

�  Outline tab: Outline view of the project (Expert edition only) 

�  Summary tab: Overview of the simulation results (Not always shown in the 

Standard edition) 

� Details tab: Details of the simulation results (Not always shown in the 

Standard edition) 
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� ESBO Wizard: A special simpler user interface for setting up a multi-zone 

simulation model. This user interface is not treated in this guide. See the 

online help texts for more information. 

 

� VELUX Wizard: A special simpler user interface for setting up a single zone 

simulation model with special emphasis on natural ventilation by windows. 

This user interface is not treated in this guide. See the online help texts for 

more information. 
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General tab 

 
 Screenshot 2 

 Start new building with a single zone 

 Modify Project data 

 Modify Location data: Geographical position,  weather  data.  

�  In this area you have access to different parameters that are valid for the 

whole building. This will be explained in more detail in Sections 6 and 9 

through 12. 

�  In this area, you have access to the structure and parameters of the air 

handling unit(s) (explained in more detail in Section 8) and the building 

plant, as well as the meters for keeping track of energy and CO2 emissions 

(explained in more detail in Section18). 

 Change the table view: Individual tables can be viewed and edited by clicking on the 

corresponding radio button. Many parameters (data related to zones, surfaces, 

windows, loads, constructions, etc.) can be changed directly in these tables. Tables 

can be sorted and data can be visualized in 3D. Make sure you understand how 

these tables work. 

 Export the input tables to Excel 

 Expand the current input table to a separate (larger) window. 
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Floor plan tab 

 
 Screenshot 3 

 Go to the Floor plan tab 

 Select an object (e.g. the building body) to edit its properties in the side bar (ensure 

that the Properties and not the Palette view of the side bar is active)  

 

NB The steps below are for orientation only, don’t try to build anything serious yet. 

 

�  Rename, cut, copy, delete, replace or edit objects (e.g. a zone) 

 Switch to palette to insert more objects 

�  Insert a new zone. How to do this is explained in more detail in Section 4. 

�  Import CAD files as background drawing.  

�  Access the IFC menu (Expert edition only) to import or map IFC objects.  

�  Protect objects to prevent them from being accidentally moved or deleted 

�  Set and remove a view filter to exclude object types from being shown 

�  Change the vertical level in the building  from where the floor plan is being 

shown 
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3D tab 

 
 Screenshot 4 

 Go to the 3D tab 

 Use the left mouse button to rotate the building, the right mouse button to zoom and 

the middle mouse button to pan. When clicking on the F-key, a new focus (for 

rotation and zoom) is set at the cursor's place. 

 Cut the building in positive x-direction 

 Move the cutting plane 

 Animate calculation results 

 Activate shadow animation 

 Start animation  

NB This is a shadow animation only. Result variables can also be animated. However, 

we do not have any results to show, since we did not simulate yet. 
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Simulation tab 

 
 Screenshot 5  

 Go to the Simulation tab 

 Start a heating load calculation 

  Press the link for Summary (Standard edition only) 

 

 

NB You can start 4 different types of simulations: Heating load calculation, cooling load 

calculation, energy calculation or customized calculation. These will be explained in 

more detail in Sections 13 through 15. 

 

NB For the Standard edition, the result report is automatically opened to display the 

heating load result and the Summary link must be manually opened. For the Expert 

edition, the Summary tab is automatically opened. 
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Summary tab 

 
 Screenshot 6  

 

After the simulation, view the Summary tab. An overview of key results from the 

simulation is given here, e.g. the heating required for each room, for each air 

handling unit, heat delivered by the plant as well as the power required from the 

utility to deliver this. 

 Visualize the  result column for Room unit heat in the 3D model.  

 Open the Details tab 

NB The complete results from each type of simulation are stored. The radio buttons 

(upper left) are used to navigate between results from different simulations. (So far, 

we have made just the heating load simulation). 
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Details tab 

 
 Screenshot 7  

 

 

View the Details tab. 

 Key time series are displayed 

 You can check extra boxes to select other time series diagrams 
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1. Building Geometry and CAD Import 

 

(This is where the detailed step-by-step example starts. Try to follow every detail from 

here) 

 

 
 Screenshot 8 

 Start with a new empty building 

 Go to the Floor plan tab 

 Choose Import 

 Choose CAD and vector graphic 

 Choose the appropriate file type 

 Browse to the desired CAD file (the DWG example used in this guide can be found 

among the samples in the IDA installation folder (Normally: C:\Program 

Files\IDA\samples\ICE\DWG example.dwg) 

 Open the chosen file and then click ‘OK’ in the Preferences window 
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 Screenshot 9 

 Open the building body menu 

 Select ‘Edit’ 

NB You can carry out several changes and then accept them by clicking the ‘Done’ 

button. All changes can also be cancelled by clicking the ‘Cancel’ button. While 

staying in the editing mode, the temporary “new” building body border line will be 

shown as a dotted line, while you can still see the original one, remaining until you 

click “Done”. 

 Move the building border to the inner surface of the external walls (stay close to 

CAD line with pressed mouse button to snap. You will recognize the snap as your 

dotted line will “jump” to the CAD line. Release the mouse button at this moment) 

 Add new points on dotted line (the new points will separate your building face into 

two parts) 



Getting Started with IDA Indoor Climate and Energy 

 

 

- 14 - 

 
 Screenshot 10 

 Move building face (part of the building border) between two points (again snap to 

CAD line of inner surface) 

 Add new points 

 Drag and drop points with pressed Ctrl-key to move them in a non-orthogonal 

direction. 

 Finalize building shape by leaving the editing mode 

 Adapt workplane size to the size of your building 

�  The coordinates of the building body can also be edited in the side bar. To get 

help finding a specific point, click on it and it will get marked in green in the 

Properties table. 

 Protect the building (and imported objects) from being unintentionally moved  

 Choose elements to be locked 

 Finalize element protection 
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 Screenshot 11 

 Mark the building body by clicking on its border 

 Set the building floor and ceiling height  

NB Default ground level is always at 0 m. This means that by default, external walls 

below zero are linked to the ground, while the part of walls above zero are linked to 

the corresponding building face. 

 Go to the 3D tab to look at your building 
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2. Define Default Constructions 

 

 Screenshot 12 

 Go to the General tab 

 Go to ‘Defaults’ 

 Open the menu for external walls construction 

 Choose ‘Load from database...’ 

 Choose ‘Concrete wall 150+80mm’ 

 Finalize selection of default construction 

NB For all external walls with no specifically defined construction, this default 

construction will now automatically be applied. 
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 Screenshot 13 

 Open the construction definition dialog for External walls 

 Change from ‘External wall’ to ‘generic’ so you can use the same construction for 

elements other than external walls 

 Add a new layer  

�  Delete the marked layer 

�  Move the marked layer one step up- or downward 

 Change the thickness of the marked layer 

 Open the material form 

�  Change the physical properties of the material 

�  U-value and Thickness of the whole construction will be recalculated 

automatically after each modification 

�  Finalize construction definition by saving with same name   

�  Finalize construction definition by saving as a new resource 

NB Objects such as the wall construction we are just making are called Resources in 

IDA. They can be accessed from all relevant places in the program. Resources which 

are copies of database objects have names beginning with . They are protected 

against modification and cannot be saved under their database name. They can 

however be saved as an editable case resource, using a different name.  
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 Screenshot 14 

 Add a new layer 

 Choose how to define the new material 

 Load from database... 

 Sort data objects by name 

 Choose ‘Air in 20 mm air gap’ 

 Finalize Material selection 

 Set layer thickness to 20 mm (= 0.02 m) 

 Save construction as a new resource 

 Set resource name 

 Finalize resource saving 

 Finalize construction definition  
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 Screenshot 15 

 Define default construction for internal walls, internal floors, roofs and external 

floors by loading them from the database 

 Open the glazing definition dialog 

�  Set your own glazing properties 

�  The shading coefficients can either be given as absolute values or reference to 

single or double pane  

 Choose how to define glazing properties 

 Choose ‘Load from database...’ 

 Choose ‘3 pane glazing, clear, 4-12-4-12-4’ 

 Finalize glazing selection 

 Finalize glass construction definition 
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3. Zone Template 

Zone templates greatly speed up the process of creating a simulation model. They allow 

the user to pre-define information associated with a zone ‘type’, instead of separately for 

every zone. All information in a zone template needs to be area-related. 

NB Zone templates are not handled as typical IDA resources. The information is only 

used during the creation of a zone. Subsequent changes to a zone template do not 

affect zones which have been attributed earlier (using this template). 

But zone templates contain references to a set of IDA resources (e.g. control setpoints, 

internal load schedules etc.). If these resources are edited, e.g. from within the zone 

template dialog, the changes will affect all objects that also reference the same 

resource. 

 

 Screenshot 16 

 Go to the Floor plan tab 

 Open the zone template menu 

 Select ‘Show/Edit zone template …’ 

 Open controller setpoints for editing 

 Define control setpoints for zone template. All setpoints are given in a single place. 

All different devices, such as for example room units, use these setpoints. 

�  Temperature setpoints can optionally be given by schedules.  

 Finalize setpoint definition 

�  Define whether zones will (initially) have local heating and/or cooling units.  

�  Thermal mass from furniture (e.g. store room shelves, furniture, plants, etc.)  

 Define default room height. 

�  In cases where several air handling units have been specified, you can specify 

which unit delivers air to this zone. 

�  Define the air volume flow control strategy as CAV 

�  Define supply and exhaust air for constant air volume flow (CAV). 
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NB For VAV (Variable Air Volume) systems, minimal and maximal supply and exhaust 

air volume rate is taken from the controller setpoints as well as the setpoints for the 

selected control strategy (humidity, CO2 and/or temperature). 

 

 

 Screenshot17 

 In the zone template form, go to the Internal gains tab 

 Select ‘ Office worker with light dress’ from database (resource for occupant type) 

 Select ‘ 08-17 weekdays’ from database (resource for occupancy schedule) 

 Open occupancy schedule 

 Insert lunch break 

 Finalize schedule modification 

 You will be asked to confirm creation of the new resource. Since the schedule is from 

the database, it will be protected against modification, i.e. make a new copy. 

 Give name for the new resource 

 Finalize creation of new resource 
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 Screenshot 18 

 For equipment and lighting, choose a schedule from the database and an energy 

meter account.  

�  In the Advanced tab, you can define specific default constructions for this 

zone type as well as maximum heating and cooling power for room units. The 

latter is only important for deliberate undersizing of room units. 

 Save the zone template as new 

 Name the zone template 

 Finalize zone template saving 

 Finalize zone template modification 
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4. Inserting Zones 

 
 Screenshot 19 

 Select the CAD object 

 Set plan height (above ground level) 

 Confirm the CAD properties 

 Open the floor plan level height form 

 Type new view level 

 Finalize view level setting 

 Go to the zone template menu 

 Choose the zone template for new zones 

NB From beginning, there is only one zone template (“Ordinary zone”) to select. As soon 

as you define other zone templates (as “Office template” in the preceding chapter), 

the list will be extended.
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 Screenshot20 

 Start inserting of new zone 

 Draw a rectangular, rough shape of the zone by starting at bottom left, intentionally 

outside the building, and going top right 

NB IDA ICE will automatically exclude areas outside the building body from the zone 

area. Already inserted zones are also automatically excluded. 

NB Having finished the drawing of the zone, the program will automatically go into the 

edit mode for further amendments to the zone geometry. 
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 Screenshot 21 

 Choose a point to be removed 

 Choose ‘Remove point’ 

 Choose ‘  Align point’ in the dropdown menu of this point. 
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 Screenshot 22 

 Move the wall to the desired location. 

NB The program automatically includes a new wall as the two walls are no longer in one line. 

 Move the second wall to the desired location 

 Move the third wall to the desired location 

 Set new point 

 Move the remaining walls to the desired location 

 Name the new zone 

 Define a zone group by giving a name. 

NB Zone groups are used to determine for example energy balance in a subset of zones, 

e.g. for a particular apartment, building section, tenant type etc. 

 Finalize zone insertion 

NB When you click ‘Done’ from the zone edit mode, values for the new zone (as loads, air 

volume rates etc.) will be calculated from area specific values given in the zone 

template. The zone is then no longer coupled to the zone template. Later resizing of 

the zone will therefore not adapt these values, unless you mark the zone, select the 

corresponding zone template and choose ‘Reset selected zones to the current 

template’ from the zone template menu. To profit from the zone template, it is thus 

important either to edit the correct zone shape before finalizing zone insertion, or to 

reset the zone later on. 

NB Note that there is a difference between moving points with or without clicking and 

holding the Ctrl-key. 
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 Screenshot 23 

 In the side bar, go to the Palette tab 

 Insert a second zone (double-clicking on ‘zone’ in the side bar has the same effect as 

clicking on the ‘new zone’ button), naming it ‘Office 1’ and assigning it to the same 

zone group ‘Offices’ 

 Insert a third zone, naming it ‘Office 2’ and assigning it to the same zone group 

‘Offices’ 

 Insert a forth zone, naming it ‘Office 3’ and assigning it to the same zone group 

‘Offices’ 

 Insert a fifth zone, naming it ‘Closet’ and assigning it to a new zone group 

‘NonOffices’ 

 Move the cursor over the zones and the zone names will appear as tooltips 

NB In case you forgot to name a zone or want to change the zone name, there are several 

ways to do this: 

• Right-click on zone and choose ‘Rename...’ 

• Right-click on zone, choose ‘Edit’ and rename in side bar 

NB The program will automatically detect how zones are thermally connected:  

• Zones are regarded as adjacent, if the distance between them is 0.5 m or less. 

• The same applies for adjacency to external faces.  

• Wall parts having no adjacent zone or face are by default treated as adiabatic 

(perfect insulation at center of wall).  
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NB There are different ways of opening a zone form: 

• Go to the General tab and double-click on the zone name in the Zones table 

• Go to the Floor plan tab and double-click the zone 

• Go to the 3D tab, mark any wall of the zone and click on ‘Open zone’ in the side bar 

 

 

 Screenshot 24 

�  In the Palette tab of the side bar, you find objects that can be inserted into a 

zone. Insert new objects by double-clicking on them or by dragging the 

symbols to the zone form. 

�  All objects in the zone of this category will be listed here, when clicking on the 

radio button of the corresponding object type. The zone template influences 

the initially inserted objects and their properties. Double-click an object to 

edit it.  

�  These parameters also come from the zone template. You can edit them here. 

�  To simulate many almost identical zones, a multiplier is defined here. All 

variables coupled with the system (system loads, supply and exhaust air 

volume rate, also natural ventilation etc.) will be multiplied by this factor.  

�  The thermal bridge loss factor of the zone towards ambient is indicated here. 

It is normally calculated from the Thermal bridge coefficients defined from 

the General tab.  

�  Values for infiltration are indicated here. They are normally calculated from the 

Infiltration parameters defined in the General tab.  

�  Boundary conditions of the different zones surfaces are indicated in this 

section in the 3D view (the same information can be reached from the 

Surfaces table. All external construction elements are shown with grey 

surface in the 3D view and marked with red in the Surface table (They are 

automatically detected as external because of their proximity to the building 

body). Double-click on the elements (in the 3D view or in the table) to open 

their forms. Floor and room height can also be changed here. 

�  Go to the Advanced tab to modify further zone properties. 

�  The Outline tab is available in the Expert edition only. 

�  Go to the Results tab to study results for this zone after simulation.  
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NB There are different ways of opening a wall form: 

• Open the zone form and double-click the wall on either 3D view or Surface table 

• Go to the 3D tab and double-click the wall 

• Go to the Floor plan tab and double-click the corresponding zone borderline 

• Go to the Floor plan tab, mark the zone, right-click its borderline and choose 

‘Open...’ 

• Go to the General tab and double-click on the surface name in the Surfaces 

table 

 

 

 Screenshot 25 

 Open the wall form 

�  Double-click on the symbols in the Palette of the side bar to insert zone 

objects to be positioned on a zone surface (alternatively drag and drop them 

in the surface editor or right-click on the surface editor and choose ‘New 

Object...’). 

�  The surface editor shows the zone surface from inside the zone, indicating 

wall parts due to different adjacent zones by dashed lines. Inserted objects 

can be positioned either here or... 

�  ... through the Properties tab of the side bar. 
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5. Inserting Windows and Internal Openings 

 

 Screenshot 26 

 Go to the view menu 

 Choose ‘Zoom in’ 

 Indicate the plan section to be zoomed in 
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 Screenshot 27 

�  In the zoomed in plan view, use the scroll bars. It is also possible to use the 

mouse wheel to move up and down in the drawing, 

 Initiate the insertion of a new window 

 Place the center of the window on a zone borderline 

�  Shift the window position after insertion 

 Open the wall form 

 

 Screenshot 28 

 Mark the window in the wall surface editor  

 Go to the Properties tab in the side bar 
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 Change the window size and position 

�  Alternatively change the window size and position in the surface form 

�  Open the window form  

NB You could also have done �-� and � directly in the 2D floor plan or in the 3D view. 
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 Screenshot 29 

 Open the window menu 

NB This action can also be carried out in alternative ways: (a) in the 2D floor plan, (b) in 

the 3D view or (c) in the Windows table of either the General tab or the zone form 

 Convert window properties to resource 

 Name the new resource 

 Finalize resource creation 

 Close wall form. You will find ‘Narrow and high’ as a new object to insert 
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 Screenshot 30 

 Start insertion of a new ‘Narrow and high’ window 

 Place the window 

 Repeat �-�  

 Use view scrolling to get to the window of ‘BigOffice’. Insert the last window and 

open the wall form to enlarge it.  

 Go to the 3D tab to have a look at your model 

NB The ‘Narrow and high’ resource name is perhaps not the most appropriate for the 

‘Big Office’ window. All other properties except the size will still be linked from the 

resource. The resource acts as defaults for all window properties. 

 

 

 
Screenshot 31
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 Screenshot 32 

 Go back to Floor plan tab 

 Insert doors as you did with windows before 

�  Open the opening form to have a look at it (See more about openings in 

chapter 4.4 of the Second Step Guide) 

 Open the View menu 

 Zoom out the floor plan view 

 Go to the 3D tab to have a look at your model 

 

  
Screenshot 33 

NB Although doors will always remain closed in the standard edition, they will have an 

impact to the air leakage path of the building, as they will act as leakage paths 

between zones. Depending on the pressure difference between the zones, air will flow 

through. 



Getting Started with IDA Indoor Climate and Energy 

 

 

- 36 - 

6. Site Shading and Orientation 

 

 Screenshot 34 

 Go to the General tab (Building form) 

 Go to the site editor 

 Alter the site orientation by turning the compass needle 

NB Make sure you select the reference point in the compass needle. 

� Alternatively change the orientation in the side bar 

 Go to the Palette tab in the side bar 
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 Screenshot 35 

Shading buildings are inserted as vertical shading plane: 

 After double-clicking ‘Shading building’ in the Palette of the side bar, set points of 

the new shading object 

 Finalize insertion of new shading object 

�  Alternatively change the coordinates of the points of the shading object in the 

side bar. The two values ‘Bottom’ and ‘Top’ define the z-coordinates of the 

object (select ‘properties’ to activate) 

NB A horizontal shading element is defined in the same way as the vertical one. It has 

however only one z-coordinate – indicating the height of the shading element 

NB Site shading objects will be defined relatively to the site and thus stay fixed, while 

external window shadings are defined relatively to the windows and thus move 

when moving the building within the site or moving the window within the wall. 

NB It is also possible to alter the geometry of shading objects in the same way as the 

geometry of a zone can be amended: Right-click the shading element, select ‘Edit’, etc. 
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 Screenshot 36 

�  Import CAD files to the site. These can be either 3D shading objects or site 

plans serving as background for drawing the shading buildings. 

NB CAD files imported into the floor plan will be rotated together with the building, 

while CAD files imported here will not. 

�  Pan and rotate (Alt-key) the finalized building within the site. 

�  Position and orientation of the building can alternatively be modified in the 

side bar 

NB Changing site orientation (compass) will rotate the building together with the site, 

whilst changing building orientation will rotate the building within the site keeping 

the site orientation constant. 

 Go to the 3D tab to have a look at your model 

 

  
Screenshot 37 
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7. Location and Weather 

 

Screenshot 38 

 Go to the General tab 

 Select ‘download’ in the Location list box 

 Search the internet web site for a suitable location 

 Accept to download 

 Acknowledge the Location installation 

�  Open the location form  

�  Examine the design day data for the location. There are two columns shown, 

for a winter and for a summer design day. 

�  Finalize location definition  

NB The Location object contains representative measured yearly weather data as well 

as design day data for extremely hot and cold days throughout the year. The design 

day data represent statistically selected cold and hot days. They will be used for 

heating and cooling load calculations. Read more about the definition of these by 

pressing the Help button in the Location dialog. 

NB The location position parameters will be used to calculate the position of the sun.  
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8. Ventilation System 

 

 Screenshot 39 

 Open the air handling unit 

 Choose between the different methods for selection of supply air temperature 

setpoint (constant, schedule or graph) 

 Choose schedule as control for the supply air temperature 

�  In case constant supply air temperature is selected, this value is used. 

�  In case the supply air temperature is based on a schedule, related data is 

defined here. 

�  In case the supply air temperature is a function of the outdoor temperature, 

the function is defined here.. 

NB The selected supply temperature setpoint is fed to the heat exchanger as well as to 

both the heating and cooling coils. To turn off any of these elements, set its 

effectiveness to 0 (by double-clicking on its symbol and modifying the parameter). 

�  Open the AHU component model objects to modify parameters. 

NB The heat exchanger effectiveness represents the percentage of the maximum 

possible heat which is transmitted between the two air streams. 

NB The cooling coil will often remove humidity  

 Modify the schedule for the operation of the fans (select ‘06-18 weekdays’ from database). 

NB The fan operation schedule controls the operation of the central air handling unit 

(on/off control). The air volume rate in each zone (when the fan is operating) is 

determined from the zone. 

NB The default AHU does not include any parameter that needs to be adapted to the 

building size. It has a very large capacity; other AHUs may need capacity data. 

 Close the air handling unit 
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9. Infiltration 

 

 Screenshot 40 

 Go to the Infiltration form 

�  In case of ‘Wind driven flow’ (wind dependent infiltration), open the table for 

pressure coefficients. 

�  Alternatively, you can open the table for pressure coefficients directly in the 

General tab 

�  Choose ‘Auto fill’ 

�  Select ‘Semi exposed’ 

NB Whenever you wish to calculate the wind driven infiltration flow, you need to 

define both the complete internal leakage paths between the zones and the 

wind pressure coefficients for all external faces.  

�  Alternatively, you can fill in wind pressure coefficients, e.g. results from CFD 

calculation or wind tunnel measurements. Note that Copy and Paste of 

rectangular sections of a table, from e.g. Excel, may be used here. 

 Here, we will not use pressure coefficient based infiltration but ‘Fixed infiltration’. 

The infiltration will then be constant and not wind dependent. 

�  You can change the units for the definition of the infiltration flow 

 Set fixed infiltration flow to 0.3 ACH (air changes per hour) 

�  You can choose, whether the air tightness and fixed infiltration flow 

respectively is distributed proportional to (a) the zone volume, (b) the 

external surface area of the zone or (c) the zone floor area. 

�  See calculated fixed flows in zones, depending on the settings at �-�. 

 Close the Infiltration form 
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10. Thermal Bridges 

 
 Screenshot 41 

 Go to the Thermal bridges form 

 Set all length specific thermal bridge coefficients to ‘Typical’ 

�  Alternatively, you can give the thermal bridge coefficients by entering their 

values into the text boxes 

�  You can also define an area specific thermal bridge coefficient 

 Close the Thermal bridges form 
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 Screenshot 42 

 Open the Zone form of ‘BigOffice’  

 Check the total loss factor for thermal bridges for the whole zone, calculated from 

the thermal bridge coefficients. 

 Open the Loss factor calculation form 

 Check the contributions of the particular origins of the loss factor 

�  Change any value for this particular zone (e.g. in case it has leakier window 

frames than the rest of the building) 

�  Choose ‘Break the link’ 

�  Finalize  

NB Values highlighted in grey indicate parameters calculated by a link to other 

parameters. Values highlighted in yellow indicate broken links. Values highlighted 

in blue indicate values taken from defaults. 
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 Screenshot 43 

�  Open the menu for the parameter with the broken link 

�  Choose ‘Mapping’... 

�  ... and ‘Restore broken link’ 

 Close the loss factor calculation form 

 Close the zone form 
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11. Ground Properties 

 

 Screenshot 44 

 Open the Ground properties dialog 

�  You can change the model for the heat transport to the ground from ISO 

13370 to a simpler model used in ICE 3 

 Open Construction dialog for the ground layer 

 Confirm dialog choices 

�  Set the ground temperature 

NB The given ground temperature is only used in the case when no whole-year 

climate file (allowing the program to calculate the average ground 

temperature) has been defined. 

 Confirm dialog choices 
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12. System Distribution Losses 

 

 Screenshot 45 

 Go to the Extra energy and losses form 

 Set hot water use 

�  You can change the units for hot water use 

 Break the link for number of occupants calculation by defining 5 hot water 

consuming occupants for the whole building 

 Select ‘Typical’ for all distribution system loss coefficients 

�  Alternatively set the distribution system by writing its coefficients in these 

text boxes 

�  Note that units can be changed for these 

�  Define what percentage of the lost energy that will enter into zone heat 

balances (the share of ducts and piping  that pass through modeled zones) 

�  Define average plant losses (permanent loss, independent of operation) 

�  Define any additional energy, such as external lighting, ice melting 

equipment etc., that do not enter into the building heat balance 

�  Close the Extra energy losses form 
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13. Heating Load Calculation and Results 

 

 Screenshot 46 

 Go to the Simulation tab 

 Open heating load calculation setup to define key parameters to be applied in the 

calculation 

 Turn off mechanical ventilation to consider worst case heating load (neglect air-

borne heating from the AHU) 

�  Define percentage of internal gains (percentage of all gains as defined in the 

zone form) that should be active during the heat load calculation (normally 

zero) 

 Select synthetic weather and constant ambient temperature -26 °C 

NB With synthetic weather, the date of the simulation as well as the clearness number 

influences solar radiation: Set clearness number to 0 % to calculate without any 

solar radiation or to 100 % to calculate with clear sky conditions. (The sky is often 

clear on cold days.).  

NB You can leave fixed ambient temperature empty to calculate ambient temperature 

from the winter design day minimum and maximum. Once a fixed ambient 

temperature has been given, the minimum and maximum dry bulb temperatures from 

the Location object are no longer used. Together with clearness number of 0 % and no 

internal gains, this means that we will do a steady state calculation with fixed 

ambient temperature and no solar radiation. 

NB Selection of ‘Design period using climate file’ requires hourly climate data for the 

period to be calculated. 

 Run the heating load calculation. For the Standard edition, the Heating Load Report 

is automatically displayed after the simulation. For the Expert edition, the 

Summary tab is displayed first. If you run the Expert edition, revert back to the 

Simulation tab and open the relevant Report link. 
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Screenshot 47 

 

 

 

 

Heating load results: 

For each zone: 

 

• Heat supplied: This is – during the heating load calculation period – the 

maximum heat supplied to the zones by all air flows and room units.  

NB Values shown are not instantaneous values, but 15 minute sliding averages. This is 

to avoid showing results for very brief extreme peaks that may occur, .e.g., just when 

the fans start in the morning. The sliding average length can be changed in the 

System parameters form, available from the General tab. 
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• Time: Time of day when the peak in supplied heat occurs 

• Room unit heat: This is the maximum heat supplied by all room units to the zone 

and you should select equipment that are able to deliver this heat. Often, ‘Room 

unit heat’ is greater than ‘Heat supplied’, since the ventilation air cools the room. 

 

 

NB The peak in ‘Room unit heat’ may occur at a different time than that of ‘Heat 

supplied’. This time is not shown in the report. 

 

• Vent. heat loss:  This is, for information, the heat lost at the time of maximum 

heat supply by infiltration and ventilation.   

• Temp.: This is the dry bulb air temperature at the time of maximum heat supply. 

Make sure that the setpoint has been reached (otherwise the available heating 

capacity in the zone was too small.) 

• Sup airflow: This is the mechanical supply air flow rate at the time of maximum 

heat supply.  

 

For each air handling unit: 

 

• Heating: This is the maximum heat added to the supply air stream by the heating 

coil(s) 

• Time: Time of the maximum 

• AHU heat recovery: The heat added to the supply air stream from the return air 

stream 

 

For the building: 

 

• Zone heating: Maximum heating power delivered by the plant to room units. 

• AHU heating: Maximum heating power delivered by the plant to the air handling 

units. 

• Total: Maximum heating power to both zones and AHUs. 

• Time: Time when the total building heating power peaks. 

 

 



Getting Started with IDA Indoor Climate and Energy 

 

 

- 50 - 

14. Cooling Load Calculation and Results 

 

 Screenshot 48 

 Go to the Simulation tab 

 Open cooling load calculation setup 

�  Define percentage of internal loads (percentage of all loads as defined) for 

cooling load calculation (normally 100% should be used) 

 Select synthetic weather  

NB With synthetic weather, outdoor temperatures are taken from design day data, i.e. 

extremely hot days that have been stored for each month of the year. For each 

month, the hot design day is repeated over and over, until the building has adapted 

as it would during a very long hot spell. 

 Run cooling load calculation. For the Standard edition, the Cooling Load Report is 

automatically displayed after the simulations. For the Expert edition, the Summary 

tab is displayed first. If you run the Expert edition, revert back to the Simulation tab 

and open the relevant Report link. 

 

 

NB If you click the More button, more options are shown. Here you can limit the cooling 

load calculation to a single month or to selected months. You can also adapt the 

severity of the design day used. By default, the most severe conditions are selected. 

 

NB Selection of ‘Design period using climate file’ makes instead the cooling load 

calculation based on a measured hot spell from a  climate file. 

 

NB The multi-simulation procedure described above assumes that full climate data, 

including monthly design days, are available for the location. Should the Location 

object only contain a single summer design day, only this will be simulated. 



Getting Started with IDA Indoor Climate and Energy 

 

 

- 51 - 

 
 Screenshot 49 

 

Cooling load results: 

 

For each zone: 

 

• Heat removed: This is – during the cooling load calculation period – the maximum 

sensible and latent heat removed from the zone by all air flows and room units.  

• Time: The time for the given peak. Note that the report collects results from all of 

the different simulations that have been done to find the worst day for each zone, 

i.e. the peak may occur at different months for different zones. 

• Room unit cool: This is the maximum sensible and latent heat removed from the 

zone by all room units. 

• Dry vent cool: This is the maximum sensible heat removed by the mechanical 

ventilation. The sum of ‘Room unit cool’ and ‘Dry vent cool’ is not equal to ‘Heat 

removed’, since the heat load due to infiltration as well as the latent heat 

removed by the mechanical ventilation are not included in ‘Dry vent cool’. 
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• Temp.: This is the dry bulb air temperature at the time of maximum heat removal. 

Make sure that this fulfills the required setpoint; otherwise, the cooling units 

didn’t have sufficient capacity. 

• Sup airflow: This is the mechanical supply air flow rate at the time of maximum 

heat removal. 

 

 

For each air handling unit: 

 

• Cooling: The maximum cooling provided by the cooling coil(s), both sensible and 

latent. 

• Time: The time for the coil peak. Note that this peak often occurs at a different 

time than zone peaks, since solar radiation has limited impact on the AHU load. 

• AHU cold recovery: The maximum recovered cooling from the return air stream. 

 

For the building: 

 

• Zone cooling: Maximum cooling power delivered by the plant to room units. 

• AHU cooling: Maximum cooling power delivered by the plant to the air handling 

units. 

• Total: Maximum cooling power to both zones and AHUs. 

• Time: Time when the total building cooling power peaks. 

 

 

 

 
Screenshot 50 

 Select ‘Summary’ within the Simulation tab. (For the Expert edition, the Summary 

tab is already open.) 

 Visualize Room unit cool 

NB When moving the cursor over the box icons in the result column titles, a tooltip 

appears.  
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Screenshot 51 

 

 
Screenshot 52 

 Select ‘Details’ within the Simulation tab. (For the Expert edition, click instead on 

the Details tab.) 

 Load data for the July simulation 

NB Immediately after a cooling load simulation, only some key results from each peak 

simulation are loaded to provide an overview of all peaks. However, to investigate 

detailed results (any variable), one must load a single peak case. This way, 

consistent results for the whole building for this hot day are displayed. Note that 

results for zones or systems that had their peak some other month also will be 

loaded. 
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 Screenshot 53 

 Go to result animation in the 3D tab 

 Choose a variable (mean air temperature) 

 Repeat for other variables 

NB You will get a selection of more variables as soon as you select more result output 

(see next exercise below) 

 Activate shadow animation 

 Open animation 

 Start animation / pause animation 

 Move within animation by dragging the scroll bar 

�  Alternatively change simulation time by typing time and day 

 Change animation speed 

 Leave result animation 



Getting Started with IDA Indoor Climate and Energy 

 

 

- 55 - 

15. Energy Calculation and Results 

 

 Screenshot 54 

 Go to the Simulation tab 

 Open list for output objects selection 

 Add Log sources to the requested outputs  

 Finalize output objects selection   

 

NB For large models, logging the sources of reports may occupy significant disk space. 
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 Screenshot 55 

 Open energy calculation setup 

�  Define percentage of internal loads that should be active for the energy 

calculation. 

NB Full loads are normally not relevant for a reasonable energy computation. 

�  Select another climate data from database 

NB Use of synthetic weather data for energy calculation is not possible. Energy 

calculation always requires annual climate data. 

 Run an annual energy calculation. For the Standard edition, the delivered energy 

report is automatically displayed after the simulation. For the Expert edition, the 

Summary tab is displayed first. If you run the Expert edition, revert back to the 

Simulation tab and open the relevant Report link. 

 

NB The structure of the delivered energy report matches defined energy meters. Energy 

meters can be defined and named by the user. Each energy consuming object such as 

a piece of office equipment is then tied to an energy meter. In the energy meters, 

factors for cost, CO2 emission and primary energy can be defined. Results for these 

will then be additionally presented in the delivered energy report (not shown in this 

example).  

 

NB The delivered energy report is in html format and therefore can easily be exported as 

a table e.g. to Excel by means of the clipboard.  
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Screenshot 56    

Building Comfort Reference 

  
Screenshot 57 

Delivered Energy Overview 
*heating value  

 
Screenshot 58 
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Screenshot 59 
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16. Simulation Summary 

 
 Screenshot 60 

 

 Select ‘Summary’ next to Cooling load the within the Simulation tab. (For the 

Expert edition, click directly on the tab, which is already open, and select Cooling 

summary in the upper left corner.) 

 

 
Screenshot 61 

NB The Summary result tables shows key results from simulations. All results from the 

last simulation in each category are kept (except from cooling load runs that did not 

show any peaks). 

 

NB Press F1 to get more detailed information about each table. 

 

NB The Cooling summary is special, since it shows an overview of all cooling load runs. 

You have to load a full peak case  in order to investigate more detailed results (as we 

did before). 
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 Toggle between the different simulation results 

 Load a full peak case from the Cooling summary. Note that key results for individual 

zones and subsystems vary between different peak cases. The Cooling summary 

shows all peaks. 
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17. Time Series Diagrams 

 
Screenshot 62 

 Load Energy run results by selecting Energy from the Summary tab. 

 Open the Details tab 

 

 
 Screenshot 63 

 Scroll down to BigOffice in the list on the left 

 Open the main temperatures diagram 

NB The ‘mean air temperature’ is the room air dry bulb temperature of the well mixed 

zone. The ‘operative temperature’ is the average of the air temperature and a 

radiation temperature. This temperature definition is closer to the human 

temperature sensation. For the Climate zone model, the operative temperature is 

measured at the location of the occupant. 

 Change time slice 

 Choose ‘Week’ 

 Step forward from week to week 

 Open the AHU temperatures diagram 
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 Screenshot 64 

 Drag and drop the outside air temperature curve from the AHU temperature 

diagram into the room temperature diagram. 
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 Screenshot 65 

 Go to the table view of the result object 

 Open the table properties 

 Change time resolution 

 Choose ‘HOUR’ 

NB The table view of result objects is in html format and therefore can easily be 

exported as a table e.g. by means of the clipboard. 

NB The measured values are integrated over the preceding hour, i.e. they are not 

instantaneous values. 

 Finalize table properties 
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18. Systems Energy Report 

 
 Screenshot 66 

 Open Systems energy report from the Energy summary  

NB The systems energy report provides an overview of all HVAC systems. This report 

also shows distribution losses from the various systems. As we did not define 

distribution losses, they are all set to zero in this example. Press F1 to read more 

about the details in the report in the help texts. 

NB The distribution losses will count as heat loads to the zones and appear in the zone 

energy balance under net losses. 
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Screenshot 67 

Used energy 

  kWh (sensible and latent) 

  
Screenshot 68 

Screenshot 69 
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Utilized free energy 
kWh (sensible and latent) 

 
Screenshot 70 

 
Screenshot 71 

Auxiliary energy 

kWh  

 

Screenshot 72
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19. More… Reports 

 
 Screenshot 73 

 Open Multizone… from the Energy summary  

 Select criterion for zone selection 

 Choose ‘Zone name’ 

  Select zones to be included 

 Generate the multizone report (report see next page) 

NB The multizone report shows the combined zone energy report for an arbitrary 

collection of zones. This report is also generated by default for each zone (Results tab 

in each zone), and for the whole building (Energy balance link in Energy summary). 
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Screenshot 74 

Zones Office 1, Office 2, Office 3 

kWh (sensible only) 

 
Screenshot 75 

 
Screenshot 76 
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Screenshot 77 

NB The Comparative report compares key results between different variants of a 

model. For this report, first make changes in your model, simulate, and save as 

separate IDA files. Use short file names which preferably display your model version 

in the first 9 characters, as only the first 9 characters of the file names are shown in 

the report. If needed, the program will add some characters to the file names to 

make them unique.  

 Open Compare results from the Energy summary of any one of the cases 

 Select cases to be compared  

 Sort your cases in the order you want to have them in the report 

 Generate the compare results report (report see next page) 
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Simulated cases 

 

Comfort Reference 

 

 

Meter Energy 
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Systems Energy 

Used energy 

kWh 
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Utilized free energy 

kWh 

 

Energy for all zones (sensible only) 

During heating 

kWh 
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During cooling 

kWh 
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